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Con Android, Google ha hecho
una apuesta arriesgada
entrando en un mundo en el

que ya brillan con luz pr opia Nokia con
Symbian, Apple con su IPhone, Black-
Berry o Windows Mobile. ÀPara quŽ
necesitaba el mundo un nuevo SO para
m—viles? Existen algunas diferencias
que hacen de Android una opci—n
muy inter esante para los fabricantes, y
c—mo no, para los usuarios y des-
arrolladores.

A diferencia de sus
competidores,
Android es software
libr e, lo que permite
que los fabricantes
puedan usarlo sin
necesidad de pagar
royalties. Por otra
parte, al correr
sobre Linux, es
f‡cilmente por-
table y adap-
table a
casi cual-
quier hard-
ware.

Android
no es el
primer
sistema
m—vil

basado en Linux y que es software
libr e. La propia Nokia abandera el pro-
yecto Maemo, e incluso Ubuntu des-
arrolla Ubuntu Mobile , pero no pare-
cen alcanzar la masa cr’tica necesaria.

Android tiene todas las papele-
tas para triunfar donde otr os
han fracasado.

Ar quit ect ura
Como ya hemos comen

tado, el coraz—n de
Android es el ker-

nel Linux,
donde se
encuentran
los drivers
necesarios
para el
acceso al
hardware,
en con-
creto, para
la gesti—n

de la

pantalla, el teclado, la c‡mara, la red
Wi-Fi, el audio y la memoria Flash,
entre otros. En principio, el desarro-
llador no acceder‡ directamente a esta
capa, sino que utilizar‡ una serie de
libr er’as que est‡n en un nivel supe-
rior y que nos abstraen del hardware.
Estas librer’as, entre las que se inclu-
yen la propia libc, est‡n programadas
en C. Otras librer’as de este nivel son
SQLLite para la gesti—n de bases de
datos, FreeType para las fuentes de
texto, WebKit y SSL para la navega-
ci—n web y el cifrado de comunicacio-
nes, e incluso OpenGL ES para aprove-
char la aceleraci—n gr‡fica del disposi-
tiv o.

Aunque estŽn escritas en C, el pro-
gramador accede a ellas desde un API
de Java, que es el lenguaje que se usa
para desarrollar en Android. Para ello,
el sistema incluye una m‡quina vir-
tual java (JVM). La m‡quina virtual
que incluye Android se llama Dalvik,
y ha sido creada por Google para
correr en dispositivos con poca memo-

ria y poca capacidad de pro-
ceso. A diferencia de la JVM
de SUN, Dalvik ejecuta
archivos .dex en lugar de
los cl‡sicos archivos .class
de Java. Los archivos .dex

son m‡s compactos y est‡n
m‡s optimizados para el

entorno del telŽfono. No dispondre-
mos de toda la API de JavaSE o
JavaME, sino que se incluye un sub-
conjunto llamado Core Libraries.

Toda la programaci—n del dispositivo
se hace usando el Framework de aplica-
ci—n, que nos ofrece todo lo necesario.
Cosas como el ciclo de vida de la apli-
caci—n o la gesti—n de recursos, se ges-
tionan desde aqu’.
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Finalmente, en la capa superior est‡n
las aplicaciones de usuario, desde el
navegador web hasta la propia aplica-
ci—n que nos permite llamar por telŽ-
fono pasando por las aplicaciones de
Google, como Maps o Gmail.

Teléfonos
El primer telŽfono en utilizar Andr oid
ha sido el HTC G1. Desgraciadamente,
en Europa s—lo lo comercializa T-
Mobile, que no ofrece servicio en
Espa–a. Sin embargo, en el momento
de escribir este art’culo, Telef—nica
Movistar ha comunicado que va a
comercializarlo (bajo el nombr e de
HTC Dream) y Vodafone est‡ a punto
de comercializar el HTC Magic (tam-
biŽn conocido como HTC G2). Proba-
blemente, cuando lea estas l’neas
ambos telŽfonos estar‡n ya disponi-
bles.

En principio, son muy par ecidos. El
HTC Dream incluye un teclado f’sico
que no incluye el HTC Magic, a cambio,
HTC Magic incorpora m‡s capacidad de
memoria ROM y una bater’a m‡s lon-
geva. En el Cuadro 1 se describen las
caracter’sticas de ambos.

El Ent orno de De sarr ollo
La œltima versi—n del SDK de Android
es la 1.1. Puede descargarse de [1]. El
SDK nos ofrece, adem‡s de un emula-
dor, todas las aplicaciones y librer’as
que vamos a necesitar para desarrollar

aplicaciones. El emulador recrea per-
fectamente un m—vil Android, por lo
que, en principio, casi todo el
desarrollo podremos hacerlo sin usar
un terminal r eal. Para instalar el SDK
s—lo hay que descomprimir el archivo
que hemos descargado en un directorio
(por ejemplo, /opt/andr oidSDK/), y y a
podremos empezar a trabajar con el
SDK; sin embargo, usarlo directamente
puede ser un poco engorroso.

Afortunadamente, han pensado en
todo y han creado un plugin para
Eclipse que nos va a facilitar mucho el
trabajo. Instalar el plugin en Eclipse es
sencillo. Lo primero es descargar
Eclipse de [2] en caso de que no lo ten-
gamos ya instalado. Lo iniciamos, y
seleccionamos el menœ Help > Soft-
ware updatesÉ Tras seleccionar la pes-
ta–a Available Soft-
ware, pulsamos el
bot—n Add SiteÉ y
a–adimos la URL
https://dl-
ssl.google.com/
android/eclipse/. Pul-
samos OK. Nos apare-
cer‡ el nuevo sitio en
el listado de la pesta–a
Available Software. Lo
marcamos y pulsamos
el bot—n Install . A par-
tir de aqu’ s—lo hay
que seguir los pasos
que nos va indicando

Eclipse. Una vez instalado, selecciona-
mos Window > Pr eferences >
Android, y pulsando el bot—n Browse,
seleccionamos el directorio donde
hemos instalado el SDK. Ya podemos
empezar a crear nuestra primera apli-
caci—n.

Modelo de Pr ogramación
Antes de crear nuestra primera aplica-
ci—n Android, vamos a exponer algu-
nos conceptos que habr‡ que tener pre-
sentes a la hora de crear aplicaciones.
Empecemos con las Actividades (Acti-
vities). Una Actividad se corresponde
con una pantalla de la aplicaci—n, es
decir, que tendremos tantas actividades
como pantallas tenga nuestro pro-
grama. Cada Actividad es responsable
de mantener su estado, de forma que
puedan integrarse en el ciclo de vida de
la aplicaci—n, que es gestionado por el
propio framework de aplicaci—n. En
Android podemos crear las interfaces
de usuario de dos formas, desde la pro-
pia actividad usando c—digo Java, o
usando un fichero XML para describirla
como si fuera una p‡gina HTML. Esta
œltima es la manera m‡s sencilla y
c—moda.

Otro elemento importante son los
Intents . Un Intent es un mecanismo
para describir una acci—n, por ejemplo,
hacer una foto o enviar un email. Todas
las acciones que queramos realizar la
haremos mediante Intents. Este meca-
nismo es muy flexible ya que, por
ejemplo, podr’amos crear una actividad
para env’o de mensajes SMS y regis-
trarla de forma que maneje el Intent
correspondiente. De esta forma,
cuando alguien quiera enviar un SMS
mediante este Intent, se invocar‡ nues-

Figur a 1: Arquit et ura de Andr oid.

Listado 1: main.xml.
01 <?xml version=Ž1.0Ž

encoding=Žutf -8Ž?>

02 <LinearLayout

xmlns:android=Žhttp://schemas.

andr oid.com/apk/r es/andr oidŽ

03

andr oid:orientation=Žhorizonta

lŽ

04

andr oid:layout_width=Žfill_par

entŽ

05

andr oid:layout_height=Žfill_pa

rentŽ />

06

07 <EditText

08 andr oid:id=Ž@+id/url_textŽ

09

andr oid:layout_width=Žwrap_con

tentŽ

10

andr oid:layout_height=Žwrap_co

ntentŽ

11 andr oid:layout_weight=Ž1Ž

12 andr oid:lines=Ž1Ž />

13

14 <Button

15

andr oid:id=Ž@+id/nav_buttonŽ

16

andr oid:layout_width=Žwrap_con

tentŽ

17

andr oid:layout_height=Žwrap_co

ntentŽ

18

andr oid:text=Ž@string/go_urlŽ

/>

19 </LinearLayout>
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Eclipse. Para mostrar las capacidades
de la plataforma, vamos a crear un
sencillo navegador web. Selecciona-
mos el menœ File > New > Pr ojectÉ
y en la ventana que aparece a conti-
nuaci—n seleccionamos Android Pro-
ject. Eclipse abrir‡ un asistente que
generar‡ el esqueleto de una aplica-
ci—n sencilla. Simplemente rellena-
mos los campos de esta nueva ven-
tana con los mismos que pueden
observarse en la figura 3 y pulsamos
el bot—n Finish. En la figura 4 pode-
mos ver c—mo queda el entorno de
desarrollo y la estructur a de directo-
rios que ha creado el asistente.
Vamos a echar un vistazo m‡s a
fondo: El archivo principal de nuestra
actividad es AndroidBrowser.java. Cada
una de las actividades (pantallas) del
programa hereda de la clase Activity . El
framework se encarga de llamar al
mŽtodo onCreate() de nuestra actividad
cuando se lanza la aplicaci—n, y en este
caso, lo œnico que se hace es, mediante
setContentView(), decirle a Android
quŽ vista queremos mostrar en la pan-
talla. La vista se referencia mediante
un archivo de recursos llamado R.java.
En principio, la gesti—n de este archivo
es autom‡tica y nosotros no tendremos
que preocuparnos por Žl, ya que segœn
se a–adan recursos, Eclipse actualizar‡
la clase. Todos los recursos de nuestra
aplicaci—n se almacenan dentro del
directorio res. En nuestro ejemplo, se
hace referencia a un recurso llamado
main , que est‡ en la carpeta layout del
directorio res. En este archivo se des-
cribe la interfaz de usuario como
fichero XML, de forma parecida a como
lo har’amos con un archivo HTML. En
este caso se utiliza un layout llamado
LinearLayout (que dispone todos los
elementos de la interfaz de forma
lineal) y dentr o una etiqueta TextView,
que muestra un texto en pantalla. Por
supuesto hay una larga lista de tipos de
layouts y de componentes de interfaz,
como botones, listas, etcÉ

En la etiqueta TextView, podemos ver
la propiedad android:text=Ó@string/
helloÓque hace referencia a una eti-
queta XML en el archivo de recursos
values/strings.xml y que se llama hello.
En este archivo almacenamos todos los
literales de la aplicaci—n, haciendo m‡s
sencilla la internacionalizaci—n de las
aplicaciones.

Por œltimo, hablaremos del archivo
androidManifest.xml, que contiene una
gran cantidad de informaci—n acerca de
la aplicaci—n, como por ejemplo, nom-
bre de la aplicaci—n, versi—n, activida-
des que la componen (tendremos que
registrar cada actividad del programa
aqu’), informaci—n de permisos y fir-
mas, documentaci—n, etcÉ

DespuŽs de este recorrido por este
esqueleto de aplicaci—n, es hora de eje-
cutarlo. En el explorador de paquetes
de Eclipse, pulsamos con el bot—n dere-
cho del rat—n sobre la carpeta ra’z de la
aplicaci—n y seleccionamos Run as >
Android application. Esto lanzar‡ el
emulador y nos permitir‡ ver a Android
salud‡ndonos. Pero no vamos a que-
darnos aqu’, vamos a continuar cre-
ando nuestro navegador.

Comenzaremos definiendo la interfaz
de usuario sustituyendo el archivo res/
layout/main.xml por el que aparece en el
listado 1. Estamos creando un cuadro de
texto para introducir la URL y un bot—n
para navegar. Todo de forma declarativa.

Al archivo /r es/values/strings.xml le
a–adimos la l’nea que define el texto
ÒIrÉÓ para el bot—n, tal y como se
observa en el listado 2.

tra actividad en vez de la actividad por
defecto para env’o de mensajes. En el
ejemplo que desarrollaremos en este
art’culo, le pedir emos a Android que
abra una p‡gina web mediante un
Intent, y el sistema operativo sabr‡ quŽ
aplicaci—n tiene que utilizar para ello.

Los Servicios (Services) son tareas
que corren en segundo plano, como si
se tratara de un demonio Unix. Imagi-
nemos que queremos hacer sonar un
MP3, pero mientras escuchamos, que-
remos poder seguir usando el telŽfono.
Mediante un servicio, podemos dejar
sonando la mœsica de fondo mientras
usamos otras aplicaciones. Una activi-
dad puede luego acoplarse a un servi-
cio para, por ejemplo, parar o cambiar
la canci—n.

Por œltimo, los Proveedores de con-
tenido (Contents Providers) almacenan
datos que son compartidos por todas
las aplicaciones. El acceso a esos datos
se hace a travŽs del API definida para
cada proveedor de contenidos. Un
ejemplo de proveedor de contenidos
que ofrece Google son los contactos
que tenemos almacenados en nuestro
telŽfono. Desde nuestra aplicaci—n
podremos acceder a los contactos
usando el proveedor de contenidos
correspondiente.

Nuest ro Primer Pr ograma
Vamos a crear nuestro primer programa
Android, y para ello vamos a usar
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Listado 2: strings.xml.
01 <?xml version=Ž1.0Ž

encoding=Žutf -8Ž?>

02 <r esour ces>

03 <string

name=Žapp_nameŽ>AndroidBrowser

</string>

04 <string

name=Žgo_urlŽ>Ir ...</string>

05 </r esour ces>

Figur a 2: Nue vo HTC Magic de Vodafone.

Figur a 3: Asis t ent e para la cr eación de una apli-

cación Andr oid en Eclipse.
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Por œltimo, vamos a a–adir el c—digo
que aparece en el listado 3 al archivo
AndroidBrowser.java. Podemos ejecu-
tarlo igual que lo hicimos antes.

Lo que realmente ocurre en este
c—digo, es que cuando pulsamos el
bot—n ÒIrÉÓ, Android tr ata de lanzar
un Intent que ya tiene predefinido
(ACTION_VIEW), y al que se le pasa la
URL (como objeto de tipo Uri). Este
Intent ya sabe que para ver este tipo de
contenidos necesita lanzar el navega-
dor del telŽfono.

En [1] podemos acceder a tutoriales
y a toda la documentaci—n necesaria
para continuar profundizando.

Andr oid Mark et
Ya llevas algœn tiempo programando
para Android y has creado tu killer
application. ÀY ahora quŽ? ÀC—mo la
distribuy o? Google ha pensado en todo
y ha creado Android Market, un sis-
tema de distribuci—n de aplicaciones,
tanto gratuitas como de pago. Gracias a
Market cualquiera puede acceder y des-
cargar nuestra aplicaci—n. Para poder
ofrecerla s—lo hay que subscribirse
como desarrollador, lo que tiene un
coste de 25$ (un solo pago).

Por otra parte, a diferencia de App
Store para IPhone, no existen requisitos
para subir una aplicaci—n, es decir, que
apenas hay filtr os, con lo que, en prin-
cipio, nadi e va a rechazar nuestro pro-
grama. A cambio, es probable que se

inunde de aplicaciones mal hechas o
que directamente no funcionen, pero
Market ofrece un sistema de puntuacio-
nes por votaci—n que pretende corregir
este problema y facilitarnos el acceso a
aplicaciones de calidad.

Conclusione s
Cualquiera que haya programado para
otras plataformas, como Symbian, sabe
lo complicado que es todo el proceso. En
especial, Symbian, adem‡s de tener un
modelo de aplicaci—n bastante complejo,
la propia Nokia pone obst‡culos a los
desarrolladores de software libre con su
modelo de firmado y restricciones de
capacidades.

En Android todo es muy diferente. El
propio sistema es libre, y tanto el entorno
de desarrollo como el framework son
extremadamente simples en cuanto se
coge algo de pr‡ctica. Para el desarrolla-
dor, Android ofrece sencillez y acceso a
todas las capacidades del terminal. �

Listado 3: AndroidBrowser .java.
01 package

es.linuxmagazine.ejemplo;

02

03 impor t andr oid.app.Activity;

04 impor t andr oid.content.Intent;

05 impor t

android.view.V iew .OnClickListe

ner;

06 impor t andr oid.net.Uri;

07 impor t andr oid.os.Bundle;

08 impor t android.view.View;

09 impor t andr oid.widget.Button;

10 impor t

android.widget.EditT ext;

11

12 public class Andr oidBrowser

extends Activity {

13

14 private EditT ext url;

15 private Button botonIr;

16

17 @Override

18 public void onCr eate(Bundle

savedInstanceState) {

19

super.onCreate(savedInstanceSt

ate);

20

setContentV iew(R.layout.main);

21

22 url = (EditT ext)

findV iewById(R.id.url_text);

23 botonIr = (Button)

findViewById(R.id.nav_button);

24

25

botonIr .setOnClickListener(new

OnClickListener() {

26 public void onClick(V iew

view) {

27 Uri uri =

Uri.parse(url.getT ext().toStri

ng());

28 Intent br owseIntent =

new Intent(Intent.ACTION_VIEW ,

uri);

29

star tActivity(browseIntent);

30 }

31 });

32 }

33 }

RECURSOS
[1] P‡gina desarrolladores Android:

http://developer .android.com/

[2] P‡gina del proyecto Eclipse: http://
www .eclipse.org/

[3] P‡gina de Android Market: http://
www .android.com/market/

[4] P‡gina principal de Android: http://
www .android.com/

Figur a 4 : Estruct ura de dir ect orio s de la aplicación.


